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Welcome to the latest edition of my monthly Final Cut Studio newsletter for, um, January, 2010. (I 
decided that if you don't change the pages of your calendar, time does not pass....)

The goal of this newsletter is to provide information helpful to the interested user of Final 
Cut Pro. This newsletter publishes each month, past issues are available in my store. All 
software references are to Final Cut Studio 2 unless otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. There you'll find 
daily tips, the latest industry news, and over 450 articles and tutorials to help you get the 
most out of Final Cut!

We are getting our social media act together! Follow-us online:

Larry on Facebook 
Larry on Twitter
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WELCOME

Well, the New Year is fully underway and my first newsletter is already late. So, I decided that, though 
the calendar may say "February," it is still January in my heart. So, welcome to the first issue of my 
newsletter for - ah - January, 2010!

This year is already starting to look much busier than last year -- which is a good thing, because last 
year closely resembled dead. Projects that we've been working on for a while are close to getting 
launched, and we have two killer seminar tours coming up - our PowerUP seminars in the US and the 
other is a two week tour in the UK and Ireland. (More on those in a bit.)

There's some great new software coming this year - I've had a chance to see some of it and can't wait 
until I'm allowed to talk about it - and we are all thinking about the implications of Apple's newest 
creation, the iPad.



Plus, I discovered several interesting techniques I want to share with you this month.

I'm optimistic for the future and feeling good about today - so let's get started and see if all this unbridled 
enthusiasm can rub off on you as well.
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THOUGHTS ON THE APPLE iPAD

The iPad had been announced less than 60 minutes, when I got 
the following email from George:

I am in the desert but in range of internet and a 3G connection. I only have a new apple 
iPad. I have taken some footage and a few jpg stills. How would i get it onto the iPad.....or 
not?

My first instinct was to point out that the iPad wasn't even shipping yet, so how could he find himself in 
this position....

Then, I realized that this was a rhetorical question that spoke to a much larger issue: "I'm a video 
professional, what do I use the iPad for?"

And that is a great question - because the iPad isn't for us. Its for the people that consume the media we 
create. The best analogy that I've come up with is that the iPad is like a TV set. Owning a TV set does 
not make you a videographer. But, if it wasn't for the millions of TV sets out there, videographers would 
not have an audience to show their work.

(OK, this is an analogy. I know that today we can watch video on everything from flat 
panel displays to Bic pens, but that's not the point. The point is that iPad is for consuming 
the media that we create, not in originating it.)

Now, I'm sure enterprising folks will figure out how to use cameras along with current and future 
versions of the iPad to originate content. After all, CNN has broadcast videos from iPhones. 

But the reason you bought an iPhone was not to be a videographer. It just happens to be a device with 
a lot of really useful stuff, that also takes pictures. 

This same thought applies to the iPad. People will buy it because it provides a fast, easy way to view 



high-quality images and video that you can then share with others. 

The process, and gear, for creating movies remains pretty much the same as it was before Apple's 
announcement. But the way we distribute, view, share, and store our videos is about to undergo a major 
shift.

It reminds me of my grandmother's house with a touch of Harry Potter. When our family got together, we 
would all sit around in the living room, passing around photo albums and telling stories about the people 
in the pictures. The iPad does the same thing, except - as in Harry Potter - today the pictures move.

UPDATE - FEB. 3, 2010 

Gerry Fraiberg adds:

After reading your thoughts on the Apple iPad, I thought you'd be interested in a couple of 
video related apps I've come accross. 
 
First is ProPrompter by Bodelin Technologies: http://www.bodelin.com/proprompter 
The app itself if $9.99. But they're also producing a package for the iPad with beam 
splitter glass with on the lens hood: 
 
Our award winning ProPrompter HD is ready to hold the revolutionary iPad, safe and 
secure while you ProPrompt anywhere your camera goes. We created mobile 
teleprompting in 2002 and were the first to create a professional teleprompting App for 
the iPhone/iPod touch along with hardware released at NAB 2009. Now with the new 
Apple iPad our base of ProPrompter App users can simply continue to use the software 
and have direct in lens mobile teleprompting at a low cost. The ProPrompter HD with iPad 
bracket will retail for $995 and begin shipping near the end of February. Email us if you 
would like to be notified when we start taking orders: sales@bodelin.com 
 
Then there is Movie*Slate, another $9.99 app: http://www.pureblendsoftware.com/
movieslate 
 
Movie*Slate is a digital slate, clapper board, shot log, and shot notepad— designed for 
use with film, television, documentaries, interviews, and home movies. Movie*Slate 
provides an easy way to log footage and take notes as you shoot— saving you time later 
when you capture and edit the footage on your computer. 
 
The apps run on the iPhone/iTouch, but would look so much better on the iPad's 9.7" 
screen. Will I get one? Maybe with the spare change after I upgrade my G5 running FCP5.

Larry replies: Thanks, Gerry. It is fascinating watching what other people can do with the platform. 

UPDATE - Feb. 6, 2010

Matt Davis writes:

- I'll be getting one to act as simple prompter for presenters, slate for interviewees ("type 
your name here, your job title here, doesn't it fit? You need to simplify it to fit..."), display 
device (previous shots, demo sequences ("we'll be putting this where the green screen 
is"). All that stuff where a laptop is't quite easy or light enough. Heck, I'll even use it as an 
impromptu lamp if necessary (I've done that with my iPhone).

Of course, a video input so it can act as a client monitor would be good (USB in from your 
camera?), or a USB adaptor so we can browse SxS or P2 and perhaps label up shots 

http://www.bodelin.com/proprompter
http://www.pureblendsoftware.com/movieslate
http://www.pureblendsoftware.com/movieslate


and browse/edit/clean up metadata. But that's getting rather more clever than Apple may 
allow.

It IS a big iphone, but then again how many times have you thought 'if only the iPhone or 
iPod touch were a little bit BIGGER, or run something more useful, or last a little longer 
than a day without power'.

Yes, got my iPad on order. :)

Larry replies: Clearly, these comments reflect a third option which I had not considered. The iPad can 
also be very helpful in production. However, I still believe that the true market for the iPad are people 
who need to display content, not create it. As always, I'm grateful for everyone's thoughts. 
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LARRY IS TRAVELING TO SCOTLAND, ENGLAND, AND IRELAND 
IN FEBRUARY

I'm heading across the 
Atlantic for two weeks 
of seminars and trade 
show presentations 
starting February 12.

Thanks to the 
sponsorship of Academy Class, Creative Loop, Dublin City University, Institute of Technology - Tallaght, 
and Red Giant Software I'm looking forward to meeting a lot of you during my trip!

First stop: Glasgow, Scotland - Feb. 12. My visit is part of the Student Media Festival at 
the Center for Contemporary Arts.

Next is London, Feb. 15 - 18. I'll be speaking at Broadcast Video Expo, as well as 
conducting an advanced Final Cut seminar for Academy Class.

Finally comes Dublin, Feb. 20 - 21. Here's I'll be presenting two seminars, one geared for 
students and new users, the second a more advanced look at the applications in Final 
Cut Studio.

Here's a complete list of locations and agendas.

Some of these presentations are free, other have a fee attached. Either way, you are going to learn a 
LOT! I look forward to seeing you there.

Click here for more information.
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BLOG - GETTING READY FOR THE FUTURE

[ The following is an excerpt from my Blog - www.larryjordan.biz/blog.  
Feel free to subscribe - I'm trying really hard to write more often. ] 

http://www.larryjordan.biz/sem/2010_uk.html
http://www.powerupevents.co.uk/
http://creativeloop.org/
http://www.dcu.ie/
http://www.it-tallaght.ie/
http://www.redgiantsoftware.com/
http://www.powerupevents.co.uk/
http://www.larryjordan.biz/sem/2010_uk.html
http://www.larryjordan.biz/sem/2010_uk.html
http://www.larryjordan.biz/blog


I'm up in San Jose, CA, this week in a series of meetings with Adobe 
learning about all kinds of interesting stuff.

During the course of our conversations, I discovered a couple of things that I want to share with you.

First, Adobe made the decision that all their future applications will be 64-bit only. For Mac users, this 
means that this will require hardware running OS X 10.6. Fortunately, Apple has made 64-bit support 
simple by building it into the OS. If you can run Snow Leopard, you are all set.

For PC users, the issue is more complex. 64-bit means that you need to buy a 64-bit-capable system. 
However, many less expensive PC computers on the market today are only 32-bit. This means that 
whenever Adobe releases new software, it won't even install on these 32-bit systems; even if you 
bought it recently.

Note: This also means that any new Adobe software won't install on Macs that can't run 
Snow Leopard; this includes all non-Intel/Macs and any system not running at least OS X 
10.6.

As a side note, the reason that 64-bit support is so important is that it provides support 
for vast - and I mean truly HUGE - RAM memory. Currently, 32-bit systems, like Leopard, 
only allow an application to access 4 GB of RAM. 64-bit systems allow applications to 
directly access HUNDREDS of THOUSANDS of TERABYTES! Sheesh....!

The second big benefit of 64-bit support, according to Adobe, is that applications run 
much faster because they need to access the hard disk much less frequently.

Better speed and faster performance are both good things in my book!

A second new technology that Adobe is talking about publicly is what they call the Mercury Playback 
Engine. Currently, this runs only in Adobe Premiere Pro and what it provides is blazingly fast 
performance for video editing.

The Mercury engine works in both software and hardware. And, using just the software engine, its pretty 
interesting.

However, when you add hardware, the speed explodes into almost frightening performance. The key 
point, though, is that the playback engine is optimized for NVIDIA graphics cards. (Meaning that ATI 
graphics cards are not supported.)

When you connect an NVIDIA graphics card to your system, performance is like nothing I've ever seen 
before. Real-time multi-camera playback of four native RED 4K files. Real-time color correction with 
multiple filters applied to the same clip. Real-time editing of native AVCHD video, no transcoding 
required.

Adobe tells me that when assisted by an NVIDIA card, Premiere Pro operates 50-100 TIMES faster than 
it does in software alone.



Here's a video Adobe produced that shows the Mercury Playback Engine in operation. 

At this point, both of these are technology demos. Current versions of Adobe Production Premium don't 
support these features. However, as you are planning your hardware purchases for the year, you might 
want to keep these thoughts in mind.

Currently, Final Cut Studio does not support 64-bit memory addressing, nor does it support graphics 
card-based hardware acceleration (Motion uses the graphics card, but the other FCS applications do 
not). 

Adobe is giving us just a glimpse of what we can look forward to later this year. Hopefully, Apple will 
follow suit.

One other note. Next generation Adobe software will also be multicore aware. This 
means that the more processors you have in your system, the faster the software will run. 
This, too, is something Final Cut Studio does not currently support.

While I don't normally talk about Adobe Premiere in this newsletter, Final Cut will need to convert to 64-
bit addressing at some point in the future, which means that these issues will confront FCP users soon, 
too.

Also, though Motion currently uses the graphics card, FCP and other applications in Final Cut Studio do 
not; yet. Still accessing the immense power locked in the GPU is inescapable, so that whether we 
upgrade our gear for Adobe now, or later for FCP, at some point this is in all our futures. 

UPDATE - FEB. 3, 2010

Tom Munnecke adds:

I've been exploring Premier Pro, and am pretty impressed with it... I like its integration 
with the rest of the creative suite, the way that the metadata carries over across the 
various media, and how much more user friendly the software is... I particularly like their 
On Location software to capture direct from camera... 

It looks to me that within one or two versions, they'll be way ahead of FCP....

It's too bad, but large companies such as Apple just lose their focus on specific products 
like FCP... And since Adobe is cross-platform, I can use either platform I want in the 
future...

Apple is falling behind, if you ask me... 

Tom Wolksy adds:

Does the computer have to be running in 64-bit mode? Because that would leave out a 
great many older Intel machine, which, while able to read 64-bit apps, cannot run in 64-bit.

Also, FXPlug filters also access the graphics card.

Larry replies: Tom, from what Adobe told me, 64-bit applications will not load or run on 32-bit systems. 
For Macs, if you can run Snow Leopard, you are OK. If you can't, you aren't. 

http://tv.adobe.com/watch/davtechtable/sneak-peek-at-the-new-adobe-mercury-playback-engine-technology/


Thanks to both of you for writing. I think this will be an interesting year for editors. 
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ALL MY 2009 NEWSLETTERS ARE NOW AVAILABLE ONLINE

Missed one of my newsletters last year? Well, not to worry. Now you can get them all!

All twelve newsletters published during 2009 have been gathered into one place -- 527 pages of Final 
Cut Studio goodies. (This is almost TWICE the pages we wrote in 2008!)

Each month's issue is a fully-searchable PDF, with all links intact, so you can refer to each issue over 
and over again. This collection contains hundreds of ideas you can put to work today to save time, save 
money, and create better projects.

Selected 2009 Headlines

�●     Jan - Blu-ray Disc Special Report and Multi-channel Audio Output from FCP
�●     Feb - Customing Keyboard Shortcuts and World's Fastest Shortcut Finder
�●     Mar - Review: Telestream Pipeline and Adding Reverb to an Audio Clip
�●     Apr - Editing Sound and Understanding Aspect Ratios
�●     May - Using the Soundtrack Pro Limiter Filter and Creating a Glowing Lantern Effect
�●     Jun - Snow Leopard Launches and Using Submixes in Soundtrack Pro
�●     Jul - Understanding RAID Levels and Fixing Out of Sync Audio
�●     Aug - Final Cut Studio (3) is Released and Interview with Apple's Richard Townhill
�●     Sep - Review Sheffield Softworks Retouching Filters and Setting Capture Scratch Disks
�●     Oct - Apple Announces iFrame and DroboPro and Euphonix Reviews
�●     Nov - Love Letter to LiveType and Creating a Vignette and Generating a Gradient
�●     Dec - Review Imagineer Systems Mocha and TONS of Reader Mail

Each issue is filled with information you can't get anywhere else. And now, everything is gathered all 
into one place!

Format: 12 PDFs stored in a ZIP file 
Pages: 527 
Price: $19.99

Click here to buy your collection today!

Looking for a bit of history? Here are all my 2008 newsletters.
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TECHNIQUE: COMPRESSING DIFFERENT VIDEO FORMATS  
INTO ONE MOVIE

I ran into an interesting problem over the weekend that I want to share with you because the solution is 
more complex than at first blush.

Here's the problem: I was asked to create a video for posting on line. The video had two components: 
me on camera talking, and screen shots.

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=163
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=91


The client wanted the finished video delivered at 720 x 405 (which is 16:9 DV) and gave me about three 
days to put this together. Given that time-frame, the only camera that I had access to shot 4:3 DV 
interlaced, while all the screen shots were captured 1280 x 720 progressive, using the Animation codec.

Yup. It was a mess.

Naturally, the first thing I did was drop everything into one timeline and let FCP handle all the 
conversions. Easy and simple. And it looked WAY past awful. 

Here's an example of a 4:3 DV image, dropped and stretched into a 16:9 ProRes 4444 timeline and 
exported for compression. Ugh! Massive stair-stepping along all edges, the complete break-up of 
images in the computer monitor and I don't look so great either.

What I discovered needed to be done was to break this movie down into components and process each 
section individually. Here are the steps I followed to create the final 720 x 405 compressed master:

CREATION PHASE - SCREEN SHOTS

�●     Create all screen shots at 1280 x 720.
�●     Edit all screen shots into final form using the Animation codec and export. 
�●     Using Compressor, convert screen shots to 720 x 405 size and ProRes 4444. 

CREATION PHASE - ON-CAMERA

�●     Record on-camera DV material as 4:3 DV.
�●     Capture and edit as normal, using the DV codec in FCP. 
�●     Export as a DV movie - in this case, I created an on-camera introduction and closing for a total of 

two finished DV movies.



COMPRESSION PHASE

�●     Using Compressor, deinterlace and compress the on-camera footage to a final movie using 
H.264 codec and pillar-box the sides so that the full image is displayed.

�●     Using Compressor, compress the final screen shots into a 720 x 405 movie. 

COMPILATION PHASE

�●     Using QuickTime Pro 7 (QT X won't work), combine the three separate movies  
into a single movie.

The advantage of this approach is that while the codec and image size remain the same (720 x 405, 
H.264), I can use different compression settings and data rates to make each video look great.

This took me the better part of a day to get the compression part right, which is why I wanted to share it 
with you here.

PREPPING SCREEN CAPTURE FILES

Lots of tutorials on how to shoot screen capture movies are available - in fact, I'll add that to my list of 
things to talk about in future issues.

For now, though, the basics are that, starting in the middle of 2009, I now record all my tutorials at 1280 
x 720. This makes them very easy to distribute on the web, which has optimized itself to display HD as 
720p video, plus shooting a progressive image makes creating smaller image sizes very easy.

Yes, 1080i video has a bigger image, but dealing with the interlacing is too much work. Everything I 
shoot now is going to the web, where 720p makes a perfect format.

So, I created, cropped, and edited all my screen captures to 1280 x 720. By default, screen captures are 
progressive, so I didn't have to worry about interlacing.

My screen capture program of choice is Telestream's ScreenFlow, which allows me to export my 
completed capture using either the Animation or Apple ProRes 4444 codec. If I were using FCP 6, I'd 
export using Animation. However, I'm using FCP 7, so ProRes 4444 is a better choice.

NOTE: My only real complaint with Screen Flow is that it records all audio on two tracks, 
which means I have to be very careful not to talk when the computer audio is playing, 
otherwise, the two audio sources will overlap, which makes audio editing impossible. 

http://www.telestream.net/screen-flow/overview.htm


I then edited all my screen captures in Final Cut Pro 7 and exported the finished sequence as a self-
contained QuickTime movie, using the ProRes 4444 codec. At this point, the file was 16:9, progressive, 
and 1280 x 720 file.

NOTE: Because my sequence was set to ProRes 4444, I exported using Current 
Settings. I much prefer exporting using Current Settings than trying to transcode 
(convert) the video into some other format during export. Compressor does a much better 
job of transcoding than FCP. 

PREPPING THE ON-CAMERA FILES

Next it was time to shoot me on camera doing the open and close to the program. 

The only camera I had available shot 4:3 DV, which differed from the screen shots in three critical ways: 
it was interlaced, it was smaller, and it was 4:3.

But, they say "necessity is the mother of invention" and my deadlines wouldn't wait, so I shot and edited 
the video using Final Cut Pro. When I was done, I exported two files: the open and the close. Both were 
720 x 480, DV, interlaced.

PREPPING THE SCREEN CAPTURE MOVIE FOR COMPRESSION

While Compressor 3.5 allows for Job Chaining, which means that the output of the first task 
automatically becomes the input for the second task, I decided not to use this at this time. The main 
reason was that I had not yet worked out all the settings. If I needed to do this on a regular basis, job 
chaining would save a great deal of time, without harming the final image quality.

For now, though, I need to get all my files into the same size prior to final compression. To do this, I will 
"pre-process" the file - get everything sized properly for final compression - then compress it in a second 
step.



1. Click the Add File button to import the screen capture file into Compressor 

2. Create a new setting file by clicking the Plus key in the top right corner of the Settings 
window and selecting QuickTime movie. (To create an MPEG-4 movie, you'd select 
MPEG-4.) 



3. In the Inspector, rename your new settings file (I used "Resize movie") and add a 
description so you'll know what this does when you look at it later. (I used "Resize movie 
to 720x405, no audio change.") Then, since all we want to do is resize the video, set the 
Audio pop-up menu to Pass-through - which means the audio is not touched. Then, 
make sure Streaming is set to None.



4. Click the Video Settings button and make sure the codec is set to Apple ProRes 4444 
(Use the Animation codec, if you are still running FCP 6). Leave the rest of the settings 
alone. 

NOTE: While ProRes 4444 is not a good format for video playback, it is an 
excellent format for transferring files between applications, or in creating 
source files, because it is virtually lossless.

5. Here's the key part. Go to the Geometry tab (2nd in from the right) and set the Frame 



Size pop-up to Custom 16:9. Then, change the Width and Height settings to 720 x 405. 
Make sure, also, that the Pixel Aspect is set to Square; or 1.0000.

6. Save your setting, apply it to the file, and Submit the file for compression. When the 
process is done - and it doesn't take very long - your finished file will be 720 x 405, 
ProRes 4444; with uncompressed audio.

NOTE: It could be argued that you don't really need to pre-process this file, 
as we could have sized and compressed this file all at the same time. 
While true, when I have a project as tricky as this one, I tend to compress 
the files in small steps, that way, I can spot a problem immediately and fix 
it, without wondering where in the process the error occurred.

Then, if I need to do this procedure on a regular basis, I would first figure 
out the workflow, then look for every possible way to automate it for all 
succeeding files. Job chaining and droplets would be my first places to look.

COMPRESSING THE SCREEN CAPTURE MOVIE

Now that we have adjusted our movie to the correct size, we need to compress it. There is a wide 
variety of software that could be used for this, but, for this example, I'll stay with Compressor.

Here's the short version, if you want to see a step-by-step version, I've created a video tutorial that 
walks you thru a similar process:

Tutorial: Compressing 16:9 HD Video for the Web 

Workflow

Import your file into Compressor. 

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=144


From the Setting menu, apply Apple > Formats > MPEG-4 > MPEG-4. This compresses 
your video into H.264, at 100% size and 100% frame rate. You can absolutely adjust 
these settings. For now, I will work with the default compression settings. 

IMPORTANT NOTE: I've found the H.264 settings in Compressor create 
very washed-out video. To compensate for this, we need to add two filters:

* Color Correct Midtones 
* Gamma Correction



The best place to add saturation to a video image is in the mid-tones. Its also the portion 
of the image than can handle the most saturation. So, in the Filters tab (3rd from right) 
check the Color Correct Midtones check box to turn it on and apply a value of 3.0 to the 
Red, Green, and Blue settings. 

Then, check on the Gamma Correction filter and increase the value to 1.05. This makes 
the image look a bit darker and richer.

I use these filter settings on all the H.264 video I create in Compressor.



Finally, in the Geometry tab (2nd from right) make sure the Frame Size and Pixel Aspect 
ratio are set correctly. In this example, we want 720 x 405, 100% of source, Square 
pixels. 

NOTE: The default setting of the Geometry tab is 320x240 - which can 
TRULY mess up 16:9 output. Always be sure to take a look at these 
Geometry settings before starting any compression.

COMPRESSING THE DV VIDEO

Now things get a bit trickier, because this DV file is the wrong size and the wrong aspect ratio. So what 
we are going to do is reduce the size of the video so it fits into 405 pixels vertically, deinterlace it, and 
add black bars on either side of the image, so that the frame is 16:9, but the image retains is 4:3 format.

NOTE: I tried cropping and zooming the image to fill the frame, but after 
deinterlacing the image looked so bad, I gave up trying.

Here are the steps:

1. Load your video into Compressor.

2. Apply the MPEG-4 setting we used above to the clip.

NOTE: This setting can absolutely be tweaked to reduce the data rate and 
other nifty stuff. This tutorial is more focused on filters and resizing than on 
data rates. For that reason, I'm just using a default setting.

3. Click the Filters tab and apply the Color Correct Midtones and Gamma Correction 
filters and settings we used on the other clip.



4. Click the Geometry tab. Make sure the Frame Size matches the other movie - in this 
case 720x405. 

To make sure your numbers are accurate, set the Frame Size pop-up menu to Custom 
16:9.



5. Also make sure the Pixel Aspect is set to Default for Size, or, my preference, Square.

6. Look at the bottom of the Geometry window. Output Image Inset Padding automatically 
adds black to the borders of an image to create pillar-boxing (black on the sides) or letter-
boxing (black at the top and bottom). I added a value of 90 to both the left and right sides, 
which means the image keeps it 4:3 shape, with black padding out the rest of the image 
to fill the 16:9 frame.

Once you are done adjusting the settings, click Submit to compress the file.

NOTE: If you don't like how the deinterlacing turned out, you can adjust this 
manually. By default, the Frame Controls should deinterlace without 
problems. But, if not, go to the Frame Controls tab (3rd from left) and 
change the settings to match this screen shot:

�●     Click OFF the auto-sensor (it looks like a large asterisk in the top left corner 
�●     Turn ON Frame Controls
�●     Set Output Fields to Progressive
�●     Set Deinterlace to Better
�●     Turn OFF Adaptive Details



When you are done, you now have several comporessed movies, all with the same image size and 
codec, but with potentially different data rates. Different data rates does not cause QuickTime any 
problems. 

LAST STEP - BUILDING THE COMPLETED MOVIE

Now that all our files are compressed and output, we need to build a completed movie. This can NOT be 
done, at the present time, using QuickTime X (shipped with Snow Leopard) but only with QuickTime 7 
Pro.

1. Open the first movie in QuickTime. Notice that it is 16:9, with a 4:3 image inside. (Oh! 
And did you notice that the image quality is a LOT better?! It also looks good when scaled 
up to full-size.)



2. Open the second movie in QuickTime

3. Choose Edit > Select All (Command+A) to select the ENTIRE second movie.

4. Choose Edit > Copy to place the entire selected movie in the clipboard.

5. Go back to the first movie and click the right pointing arrow with a line to jump the 
Playhead to the end of the movie. 

6. Select Edit > Paste to paste the entire second movie at the position of the Playhead. 
You have now combined two movies into one.

7. Open the third movie, Select All and copy it to the clipboard, just as before. 

8. Go back to the first movie. Be sure the playhead is at the far right end of the Timeline; 
use the "Jump to End" button to position the playhead to the far right, if necessary.

9. Edit > Paste the third movie.

10. Move your playhead back to the beginningof the Timeline, and make sure the In and 
Out indicators are both dragged to the beginning of the movie. 

11. Choose File > Save As. Give your file a name and make sure to save it as a self-



contained movie.

All these different movies are now in the same movie, with the same size, same codec, and look great. 
There are lots of ways you can vary this procedure for different file sizes, frame sizes, and compression 
settings. But in all cases, the basic workflow remains the same.

Done. Whew! 

UPDATE - FEB. 3, 2010 

Mark Trenary adds:

In respect your article about outputting MPEG4 files, I was recently wanting to encode 
using MPEG4 format Part.10 i.e. H.264 codec.

Some searching Apple forums and several trials later I concluded I couldn't export from 
Compressor using H.264 codec in MPEG4 format (apart from the device presets or of 
course using a QT .mov container)

Rather one must export using QuickTime 7 conversion, select Movie to MPEG-4, click 
options then change File Format to MP4 (not ISMA), now you can select H.264 as your 
codec. The select H.264 video format.

A potential issue I assume is that by deselecting the Internet Streaming Media Alliance - 
the compatibility with other players is not guaranteed.



  
  
  

For what its worth, Compressor MPEG4 export files are reported to be using "MPEG4 
decompressor libavcodec".

whereas QT MPEG4 exports as described above are reported thus:



  
  
  
  
  
  
  

I'd be interested in clarification from readers about exporting compliant MPEG4 files using 
MPEG Part.10 H.264 codec. Would there problems with playback selecting the non ISMA 
format for web publishing of MPEG4 movies?

Larry replies: Thanks, Mark, for this additional information. 

Tom Wolksy adds:

Animation is a truly horrible codec for editing. Why not use PhotoJPEG or something 
else, or is Animation all that the screen capture app would produce? Why 4x4? It seems 
such overkill for such a small frame resolution> Or was there some need for 
transparency?

Also, I think selecting Export Chapter Markers will work as well.

Finally, I don't think we can even make a reference movie for H.264 video. 

Larry replies: Thanks, Tom. In my case, the Animation codec was determined by the screen capture 
program. And I agree, if you don't need transparency, ProRes 4444 can be more than you need. 
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BLOG - LOOKING FORWARD BY LOOKING BACK

[ The following is an excerpt from my Blog - www.larryjordan.biz/blog.  
Feel free to subscribe - I'm trying really hard to write more often. ] 

Last Thursday, on the Digital Production Buzz, Mike Horton and I interviewed 
Ken Miller, formerly the #2 executive - and 20-year veteran - at Aaron Spelling 
Productions, and now head of his own production company - My Media 
Productions.

It was great fun to talk with the producer of such massive hits as 

http://www.larryjordan.biz/blog
http://www.digitalproductionbuzz.com/
http://www.digitalproductionbuzz.com/
http://www.digitalproductionbuzz.com/


"Love Boat," "90210," "Charmed," and dozens more. He had a 
very simple philosophy - focus on the story. However, in this case, we got him to 
describe his process in more detail.

Ken's background was editing with film. He started as a music editor and worked his 
way up. Toward the end of our interview we discussed the impact tapeless media is 

having on episodic production, as well as the changing dynamic of funding production.

Mike and I both found the interview fascinating. I've created a special excerpt of it, which you can listen 
to here: (TRT: 14:41)

Click to play the Ken Miller audio interview from Digital Production Buzz

Or, click here to view the contents of the entire show:

Digital Production Buzz - Jan. 28, 2010
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LARRY IS TRAVELING TO WASHINGTON, DC

My PowerUP Seminar series continues next week - Feb. 10 - in Washington, 
DC.

Thanks to the generous sponsorship of Red Giant Software and Smartsound, 
we are able to make our registration pricing VERY AFFORDABLE -- only $99 
for a full-day of training.

�●     The seminar covers: 
�●     Trouble-shooting Final Cut Pro 
�●     Working with Alpha Transition and Channels in FCP 
�●     Improving the look of your projects
�●     Integrating Soundtrack Pro with FCP
�●     Precision Audio Editing
�●     Adding Music
�●     Mixing your project
�●     Video Compression Power techniques

Plus, there's PLENTY of time to get your questions answered. 

We only have about seven seats left. Class size is small to make the learning more personalized. This is 
my only trip to Washington this year, so please register today!

Click here to learn more.
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TECHNIQUE: GETTING ANALOG VIDEO FROM A MACBOOK PRO  
TO AN SD TV

David Tindale, from Australia, sent me the following technique:

http://www.digitalproductionbuzz.com/BuZZ_Audio/Miller_K_Buzz_100128.mp3
http://www.digitalproductionbuzz.com/Archives/ShowNotes.php?date=2010-01-28
http://www.larryjordan.biz/seminars
http://www.larryjordan.biz/sem/2009_us_fall.html


Here is my work-around to get an analogue video signal from a Macbook Pro to an SD 
TV.

First you need to purchase a Mini DVI to VGA adaptor ($45 approx. in Australia), then 
you need an AV to VGA Digital Scan Converter Box (anywhere from $30 to $70 Aus.). 
The Converter box comes with an RCA cable, a VGA cable, a USB power cable and the 
converter box itself.

It's fairly straight-forward to connect:

�●     Plug Mini DVI into Computer, connect VGA cable to Mini DVI adaptor.
�●     Connect other end of VGA cable to Converter Box, plug RCA cable from 

Converter box to TV.
�●     Connect USB power cable to Converter box and computer and Bob’s your Aunty’s 

live in lover.

The real problem solving came with getting the Macbook and TV to see each other. The 
solution that worked for me is as follows:

Select System Preferences > Displays

Set resolution to the same as the TV (for me this turned out to be 720 X 480 stretched). (In the US, it 
would probably be 720 x 480. LJ)



Go to ARRANGEMENT and make sure Mirror Displays checkbox is selected

In FCP go to VIEW drop down menu and set EXTERNAL VIDEO to ALL FRAMES. I was 
then able to playback full screen and check color correction.

There are a couple of problems with this workaround, one is that you’re working in a very 
low resolution with FCP so I don’t recommend editing, this is just for viewing and 
checking.

Another is, when resetting the resolution to go back to editing, make sure you have 
UNCHECKED the Mirror Displays checkbox BEFORE resetting resolution.

I made the mistake of resetting resolution first and my computer freaked out, it flashed 
through a number of resolutions before settling on a black screen that I couldn’t get out 
of. I ended up having to reboot my computer (this is a trap for young players)

I hope this will help anyone else who has had the same problem as me of having to work 
with SD as well as HD footage. All-in-all the fix cost me about $70 including postage.

Larry adds: Thanks, Dave, for writing this up.
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A COMMENTARY ON LEARNING

Ben Balser, an Apple-Certified Trainer for Digital Media, sent me the following commentary on investing 
the time to get trained. By way of background, Ben is a long-time educator and trainer. (I've edited his 
remarks a bit to reduce size.)

The problem [begins] when folks claim they don't have time to take a class, or do the 
Apple Pro Training Series (APTS) books, and claim they "have to rely on forums, trial and 
error" because of their limited time. Oh my goodness, let's set the record straight, shall 



we?

Simple fact of life; you can waste time figuring out problems on the fly, or take an hour or 
so a day, do a chapter in the APTS book, and by the end of your big video project, you're 
up to speed, and have spent a fraction of the time doing the book that you would 
otherwise have spent figuring out problems. You're choice how you spend your time; less 
time with the book, more time on forums and bashing your head against brick walls....

I have found many who go the "forums and experimenting" route spend a full hour plus a 
day in troubleshooting a common issue, or trying to figure out how to get an effect, or how 
to get some process to work. Had they spent that hour plus time with an APTS book 
doing the chapter that covers that issue, they'd not only have the issue settled, but they'd 
know much more about how the apps work, and will be more prepared to work faster, 
easier, and reach that deadline faster.

And the books are really easy to do, you can get through them pretty quickly. My personal 
recommendation is to take one hour or so every day after work, and do one chapter of an 
APTS book. In two weeks you're done, and you're working faster, easier, more 
productively, and more creatively. Even experienced editors who are self taught, discover 
after the class is done that they're editing time just got cut in half and are very surprised 
how much they did NOT know about FCP.

The excuse that "I learn better from watching a video" or "I can only learn from an actual 
teacher", is plain out laziness. Yes, I said "laziness"! Anyone can do the APTS book just 
fine, if you take the time to do it, and doing training in a book like that will help you retain 
the knowledge faster and longer. This type of hands on, and self motivated, is the best 
quality education. Do the book, take a class, or spend much more time and money trying 
to figure it out on your own.

Larry replies: Ben, thanks for writing. While I believe that folks learn in different ways, including video, I 
also agree with you that taking a formal course - whether by book, online video, or classroom, can make 
a world of difference in editing speed and quality.

That's one of the reasons I enjoy teaching.
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PASSING THOUGHTS

A collection of interesting tidbits that crossed my desk this month.

USING A MOUSE WITH YOUR HEAD

Ben Wyldeck sent this in:

I stumbled across this video today and decided that this is the way forward for FCP 
editing - http://www.youtube.com/watch?v=0s5iqRpWH9c. Its good to be livin' in the 
future!
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WHITE SCREENS IN FINAL CUT PRO

http://www.youtube.com/watch?v=0s5iqRpWH9c


David Smith, from the UK, sent me the following:

Larry, Final Cut was only displaying white screens in both the Viewer and Canvas. I 
trashed preferences, and nothing was fixed. Then, Vicki Parks-Murphy showed me the 
secret. The whiteout was caused by the OSX display settings. The color setting was set 
to iMac, which should have been fine but wasn't. 

So what I had to do was select another profile, then switch it back to iMac, this re-sets it 
(first though make sure FCP is quit). Then I had to trash all FCP's prefs and bingo it's all 
back. It wasn't a QuickTime driver at all.
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RESETTING KEYBOARD SHORTCUTS

Alexander Snelling shared this tip on a recent mailing list:

[If you are having problems changing keyboard shortcut layouts,] if you are using 
anything other than a US keyboard (and I have taught using most European keyboards) I 
find it helps to click reset before changing the keyboard layout settings. Kinda flushes out 
any little anomalies that might be lurking.
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SET IN AND OUT TO MARKERS

Here's a cool trick sent in by David Smith:

In FCP, if you set two markers in the Timeline and put your playhead between them, 
select Mark > Mark to Markers (or type Control+A) to set the In and the Out to match 
the position of the two markers. (This doesn't work in the Viewer, just the Timeline.)

[ Go to Top. ] 



THOUGHTS ON TRAINING

Kit Laughlin, from Australia, writes:

As a workshop presenter myself, I loved your analysis of Motion (EDITORIAL: TRAINING 
THAT DOESN'T TEACH). This is THE problem in learning new software: the tutorial 
authors assume that the newbie understands the context in which the new software is 
situated, or that the newbie understands how the software thinks. Explaining how a 
function in some Tab works is not a substitute for this scene-setting. A huge two thumbs 
up to you for pointing this out.
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THOUGHTS ON SSD DRIVES

Kit Laughlin continues:

This brings me to the subject of solid state drives (SSD): I intend to build a new boot drive 
using one of these in an enclosure (to fit in the top disk drawer in the big machine), both 
to get past the "two users" problem, and to increase system responsiveness. I have an 
SSD in my laptop, and the difference in speed (opening new programs) between the SSD 
and a fast orthodox drive is simply incredible. 

For example, opening PS on the laptop takes ~4 seconds; on the Quad core desktop, it's 
over 10 seconds. Expect the same order of speed increase on opening all FCP-related 
software; the feel of this when working is an incredible improvement.
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INLAND EMPIRE (CALIFORNIA) FILMMAKER GROUP

Eric Harnden writes:

I have begun organizing a local film making enthusiasts group called the "Independent 
Filmmakers of the Inland Empire".

The purpose of the group is to unite like-minded who enjoy filmmaking or some aspect of 
it. The plan is to provide A) camaraderie, B) education and C) support to the local 
filmmaking community.

The group is for the general public and will allow for many networking opportunities. I am 
basing the group organization and meetings off of successful meeting groups that I have 
been apart of. We will provide speakers, demonstrations, showcases and most 
importantly: RAFFLES!

I am looking for 1) members, 2) speakers and 3) sponsors!

Please see page: wordpress.quintessentialstudios.net/?p=255 for more info.
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SOMETHING WORTH WATCHING

Kevin Brumfield, and Fredrik Andersson both sent this in:

Here is a link to an incredible, full-CG, short by Alex Roman. He is a one-man-band, and 
must have put in an amazing amount of time to create this. While watching, I found 
myself saying several times, "this has to be real footage."

http://vimeo.com/7809605?hd=1
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RECORDING WITH THE CANON 5D MARK 2

JH Fleming sent me this link:

How to record sound with the Canon 5D Mk2 and a great plug in for Final Cut for auto 
synching, by Philip Bloom.

http://philipbloom.co.uk/2009/05/23/how-to-record-sound-with-the-canon-5dmk2/
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FIXING THE X.264 ENCODING BUG IN COMPRESSOR

Chris sent me the following:

[Larry, you've written that creating H.264 files in Compressor looks washed out.] Over the 
weekend, I tried googling things once more and came across a blog post describing a 
similar issue that I was noticing. I tried this approach as well by creating an H.264 mov 
using the *original* Compressor settings, and it produced very good results as well. I'm 
passing it along in case you're interested:

http://ahrengot.wordpress.com/2009/09/12/tip-how-to-fix-the-quicktime-h-264-gamma-bug/

I didn't use the vectorscope to do a more technical comparison due to time, but of the two 
options (using "correct" Compressor settings and the x264Encoder approach), the 
x264Encoder solution seems to yield a slightly more color accurate H.264 encoding for 
me. The only downside is it requires an additional exporting step after it comes out of 
Compressor.

Larry replies: Thanks, Chris. I haven't tested this, yet, but wanted to share it with readers looking for a 
way to improve their H.264 compression.
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GREEN SCREEN HANDBOOK

http://vimeo.com/7809605?hd=1
http://philipbloom.co.uk/2009/05/23/how-to-record-sound-with-the-canon-5dmk2/
http://ahrengot.wordpress.com/2009/09/12/tip-how-to-fix-the-quicktime-h-264-gamma-bug/


Jeff Foster tells me he has finished his latest book: The Green Screen Handbook.

Publication date is March 8. Here's the link: http://pixelpainter.com/
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ANOTHER GREAT IPHONE APP

John Stealey sent this in:

Discovered another iPhone app:

www.usatoday.com/tech/columnist/edwardbaig/2010-01-13-dragon-dictation-iphone_N.
htm

You talk - it types - great for location notes - give this a shot! No need to look for paper 
and pen to take notes or use the keyboard on the iphone, simply talk then send your 
spoken message which has been magically converted to text to anything - I find it very 
useful and very fast for scouting locations and making really quick location production 
notes I might need later. Best thing about it - it's FREE! 
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MORE FCP FILTERS

Jeff Brenes, from Costa Rica, sent me this:

I recently found out a punch of free nice filters for FCP / FCE, that may be helpful for 
some people and thought to share them this way. (I don't know if you already know or 
write about them, but in case not here there are)

The filters are developed in fxscript by Piero Fiorani (PieroF), and have some nice 
features for video effects.

The most remarkable filter is a version of the alpha transitions currently packaged in FCP 
7, fully functional to use in older FCP versions.

Other filters are:

�●     Reflections: video reflection effect, the final video looks similar to the reflections in 
the main menu of Front Row

�●     Time Remap: allows to keyframe the speed of the clip so the clip will play at 
different speeds in different timecodes

�●     Clone: clones a rectangular area of a clip into a different area in the same clip
�●     There are several effects filters more.

Here's the link: 

web.me.com/piero.fiorani/PieroF_FCE_Effect/Welcome.html
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READER MAIL

GETTING STARTED WITH FINAL CUT PRO

Nicholas Jacobs writes:

My 10 year old ACTRA actress daughter (acting since she was 5) wants to produce films. 
She's very creative and a good actor and very good with voice work. 

It was suggested that she write a short story and use stuffed animals as characters, film it 
herself, do the voice work and then work with Dad on an iMac to produce a film. We have 
not bought the iMac yet, and will probably start with iMovie, but may move to Final Cut 
Express if we need to.

Can we do this with Final Cut Express (not the pro version).

I want to get her started, hopefully with our Canon (as there are just too many options on 
HD right now) camera and hopefully iMovie and grow from there.

Any advice you can give would be greatly appreciated.

Larry replies: Thanks for writing - and my best wishes for Elizabeth's success. At ten-years-old, even a 
highly motivated kid may not be ready to make a dedicated career commitment. So, as the father of a 
daughter myself, here's my take:

1. The hardest part of producing a movie is PLANNING! Thinking thru clearly what your 
story is, how you want to shoot it, and how you want it to look. Draw sketches of key 
scenes. This does not require any software - pencil, paper, and brainpower is all that's 
necessary. This process is frustrating, difficult, time-consuming, and absolutely 
necessary. Oh, and it is also great fun.

2. The second hardest part of producing a movie is getting it shot. Making it look right. 
Telling your story the way you want. This, too, does not require any software; just a 
camera.

3. If you survive step 1 and step 2, the editing is the least of your worries. I would opt for 
cheap and easy - iMovie is fine. So is Sony Vegas on the PC. Don't get hung up on tools 
at this point. You are deciding if you like the process.

4. If you can plan a movie, shoot a movie, and edit a movie that others want to watch -- 
and you want to do it all AGAIN -- that is the point to invest in the tools to become 
successful.

For now, it is enough to try.
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BATCH EXPORT VS. COMPRESSOR

Kevin Spaan asks:



I was recently editing a musical and had several special features. I recorded and edited it 
in 1080i HDV and then I batch exported all of the sequences to ProRes 422 DV format. 

I then compressed to DVD. 

Will I see an improvement in your process of using Compressor over what I did here? 
Thanks!

Larry replies: I would expect files converted in Compressor to look better. Plus, Compressor runs in the 
background, while Batch Export requires FCP to be running; preventing you from doing any editing 
while the export is going on.

UPDATE - FEB. 3, 2010 

Lee Berger adds:

Another feature in compressor not available in batch export is crop, handy when you want 
to crop out visible blanking in the frame.

Larry replies: Thanks, Lee, I agree. 
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CREATING A BLU-RAY DISC

Jan Bliddal asks:

Can you lower the bit-rate enough when burning to Blu-ray for it to fit on a 8.5GB dual-
layer red laser disk or will I have to invest in a Blu-ray burner. I will be using the latest 
version of Final Cut Studio.

Larry replies: Yes and no.

Final Cut Studio (3) allows you to create what Apple calls an AVCHD Disc. This formats video to meet 
the Blu-ray Disc specifications, then burns it to a standard, single-layer DVD using a red laser.

Normal compression data rates for AVCHD are about 1/3 less than standard Blu-ray Discs, but the 
images still look good - much better than SD video.

That's the good news. The bad news is that you are only able to burn 20-30 minutes of material to the 
DVD. Which means this is a good alternative to Blu-ray for short subjects, but not acceptable for longer 
projects.
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BLU-RAY QUESTIONS

Ben writes:



I have been trying out the new Blu-ray features in Compressor 3.5 and was impressed 
with the results however …

I was trying to produce a looping Blu-ray with 3 separate audio tracks (one is 5.1, two is 
stereo wide dynamics, three is stereo smaller dynamics) It seemed very unclear which 
track gets used for the authoring of the Blu-ray disk or how to get this to work.

Any tips?

Larry replies: You can't do this with either Compressor or FCP.

On the Mac, this kind of authoring can only be done using Adobe Encore, which is a part of the Adobe 
CS4 Production Premium suite. 
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GETTING 16:9 PROJECTS TO LOOK RIGHT

Ian Absolon asks:

I produce animations in Motion in 16:9 then save them to a Motion file. I then import it into 
an FCP timeline (again 16:9). I always have too use Motion tab > Distort aspect ratio to 
change from 33.33 to 0.

What am I doing wrong?

Larry replies: My first guess is that you are not creating them as 16:9 projects in Motion.

If you are, then sure after importing the file into the FCP Browser -- and before editing it to the Timeline 
-- to check the Anamorphic column in the Browser. Checking transforms a 4:3 clip or project into 16:9. 
Changing the Distort settings in the Motion tab is never a good idea. 

HD footage does not need the Anamorphic field checked, this is used only for SD PAL or NTSC.
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SETTING DVD SP TRACKS FOR 16:9 VIDEO

Trent Anderson asks:

I am exporting a 16:9 video project from FCP, using Compressor. No problem, it sends 
the M2V video and AIFF audio file to a source folder.

Then, I import the assets into DVD SP and drag them into the Track Editor. Then, in the 

http://www.adobe.com/products/creativesuite/production/
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Outline Viewer I click on the Track 1, and it brings up a Track box on the right, where I 
can select Display Mode, and choose either 4:3, 16:9 Pan Scan, 16:9 Letterbox, or 16:9 
Pan Scan & Letterbox. This is for a trade show video, and the client will be playing it in a 
DVD player onto a wide screen TV, e.g 42". Which of those three settings would be the 
best one to use, so that it will properly fit the screen?

Larry replies: Assuming you are using SD video, as DVD SP does not support HD, and assuming, also, 
that you are exporting your moive in 16:9 format, you would set the track in DVD SP to 16:9 Letterbox.

NOTE: The Pan-and-Scan formats require pan-and-scan data generated by software that 
is not included in Final Cut Studio. 
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CREATING 16:9 VIDEO IN DVD STUDIO PRO 

David Scott writes:

I've decided to begin creating my shows in 16:9 SD (heretofore they've all been 4:3). I'm 
assuming that most folks by now have acquired 16:9 TVs. My question is this: Do I need 
to worry about anamorphic settings in FCP? I'd like the DVDs I distribute (prepared in 
FCP in 16:9) to fill the 16:9 screens of my recipients and, preferably, appear letter-boxed 
when viewed on a conventional 4:3 set.

Larry replies: This is a multi-step process. Here's the short version. Provided you maintain a 16:9 aspect 
ratio throughout shooting and editing, all recent DVD players will properly display 16:9 video on both 
16:9 and 4:3 TV sets.

(And, yes, you need to worry about the anamorphic setting - see the answer above. All widescreen SD 
video needs the anamorphic setting turned on.) 

The specific production steps are:



1. Shoot your video using 16:9 settings on your camera. These are often called wide-
screen or anamorphic. While these two terms don't mean the same thing, they are often 
used interchangeably.

2. Create your sequence in FCP using anamorphic settings. For example, for DV footage, 
using DV/NTSC 48 kHz - Anamorphic. All HD video is always 16:9 and doesn't use the 
anamorphic setting. 

3. Export your finished movie using File > Export > QuickTime Movie, set to Current 
Settings. DON'T worry about how your video looks in Quicktime - it will probably look 
squished. This is normal. 

4. Compress the file in Compressor and be sure the Geometry tab is set to an Aspect 
Ratio of 16:9 (see my Compression article earlier in this issue.)

5. Import the compressed file into DVD Studio Pro. 

6. Create a new track in DVD SP. Select the track and make sure the Display Mode, in 
the Inspector, is set to 16:9 Letterbox. (See the preceeding answer for the screen shot.) 

Following this procedure will display your video as 16:9 on flat panel displays and letter-boxed on older 
4:3 TV sets.
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CONVERTING HDV VIDEO TO A LETTER-BOXED DVD

Eric Wrate writes:

I shot HDV on a Canon HV20. Edited it on a iMac using the latest version of FCP. I now 
need to be able to burn a "letterbox" version (i.e. black bars top and bottom - showing a 
16:9 image).

Can you tell me in simple talk how to achieve my goal. I am only using FCP and Toast 9 
(I have their Plug in HD/BD plug in).

I have previously done this by editing in HDV - when finished I highlighted my time line 
and copied it. I then opened a new project - and set the Easy setting to DV-NTSC and 
"pasted" the copied file into the new project. I then rendered it and saved it (it took a time 
for this) - but it worked. I have tried this - now, and it does not work. 

Have they changed something in the new version of FCP?

Larry replies: Not necessarily, but probably -- it's a new dialog in FCP 6. 

Before we start, let me stress something you mentioned. When you want to put video on a DVD, it must 
be standard-def, not high-def. HDV is a high-def format. Blu-ray Discs (and its cousin, AVCHD Discs) 
are the only options for high-def media on optical discs. 

So, here are the steps to get started:

�●     Convert the HD into SD video
�●     Compress it
�●     Get it to play letter-boxed.



There are three ways you can do this:

Option 1. Create a new SD timeline. You can use DV/NTSC, but I prefer using DV50 - 
the files are twice as big, but the image quality is better. Then, copy and paste JUST ONE 
HDV CLIP into this new sequence. 

When you see this dialog, say No. This tells Final Cut not to change the sequence 
settings to match your clip. (This dialog first appeared in FCP 6.)

Delete the clip you just pasted into the timeline.

Copy your entire HDV sequence and paste it into the Timeline. Now that you've properly 
configured the timeline, everything should be properly letter-boxed.

This is an improvement on your method and it works, but I tend not to use it, as I prefer 
how Compressor changes the size of a clip.

Option 2. Export your sequence from Final Cut Pro as an HDV movie. (Use the Current 
Settings option with File > Export > QuickTime movie.)

Compress the file using Compressor using the appropriate DVD Best Quality settings 
from the Apple > DVD folder. This automatically down-samples your movie to SD and 



compresses it for DVD.

Import your movie into DVD Studio Pro and place it into a 4:3 track.

This works, but I prefer to have letter-boxing turned on only for those TV sets that require 
it. This option letter-boxes everything and could cause problems with 16:9 TV sets. My 
preference is the third option.

Option 3. Export your sequence from Final Cut Pro as HDV. 

Compress the file using Compressor using the appropriate DVD Best Quality settings 
from the Apple > DVD folder. This automatically down-samples your movie to SD and 
compresses it for DVD.

Import your movie into DVD Studio Pro and place it into a 16:9 track. 

This displays your movie at 16:9 on TV sets that support 16:9, and automatically letter-
boxes your movie for TVs that only display 4:3.

For me, this third option provides the fastest workflow (no additional rendering in Final Cut Pro), highest 
quality (Compressor does a better job than Final Cut Pro), and greatest flexibility (16:9 and 4:3 support, 
depending upon what the TV set displays).

UPDATE - FEB. 4, 2010 

Bill Megalos adds:

When I work with HDV and am looking to output an SD DVD, I let iDVD do all the heavy 
lifting. File> Export>QuickTime Movie using current settings, (ie, you will end up with a 
1440x1080 QT file) and let iDVD do the conversion to SD. Much faster and looks fine, 
especially if you choose Professional Quality in the preferences 
iDVD>Preferences>Projects>Encoding>Professional Quality. 

That should handle at least 30 minutes, if it balks at that, choose High Quality. Please 
note that changes apply ONLY to subsequent projects, so check/change you preferences 
and then start the project.

MUCH faster than downconverting in FCP or Compressor and I think it looks better than 
FCP and possibly as good as Compressor.

Larry replies: Bill, this is a great tip and something I didn't know. Thanks! 

[ Go to Top. ] 

RETAINING CHAPTER MARKERS IN H.264 VIDEO

William Aleman provides this update:

[Last month, Ben Balser asked a question on how to retain chapter markers in H.264 
video.] I've successfully exported the Chapter Markers to iTunes, iPod, and QuickTime 
players without any extra steps or work around using FCP 6.0.6



I think that the missing step in the process here is that the users are not adding or 
converting the editing markers in FCP's Timeline to "Chapter Markers" before they export 
the self containing QuickTime Movie. Following are the steps.

Create the Timeline Markers

Convert the Timeline Markers to Chapter Markers in the Edit Marker dialog by clicking 
the Add Chapter Marker button. 

Export a self-contained QuickTime Movie. 



Important note: When you want to include markers as part of your export 
from FCP, it is essential to select DVD Studio Pro Markers in the Export 
dialog. Otherwise, your markers will not export properly. Larry. 

Second Note: Reference movies do not retain chapter markers, only self-
contained movie do.

Compress the exported movie to H.264. (It has a .m4v file extension.) and add the H.264 
movie to iTunes

In iTunes 9 Menu, next to Help, in the top right is the Chapter menu. Click and hold it 
down to reveal the chapters list.

The second method to display chapter markers is in the iTunes and QuickTime transport. 
Click and hold down the chapter icon in the right side of the playback transport.



To display the chapter markers in iPod:

�●     Double click the center button in the iPod. A bar containing little divided rectangles 
will appear. Each division correspond to each chapter.

�●     Press the back or forward button in the iPod to display and navigate to the 
chapters.

One more thing: The chapter tab doesn't appear in iTunes Menu until a video with 
chapters is in playback or pause mode.

Larry replies: Thanks!

[ Go to Top. ] 

USING MPEG STREAMCLIP TO CONVERT TO APPLE PRORES

Connor Jay writes:



I had a question I was hoping you might know the answer to -- my MPEG Streamclip 
does not have the options to convert my 5d MK2 videos into Apple Pro Res. Attached is a 
screen shot of the option available to me. Did I download the wrong version of the 
program or should I choose 
one of the options listed to try compress my videos for Final Cut?

Larry replies: Connor, you need to have Final Cut installed on a system for ProRes to be active.



I just downloaded the latest release of MPEG Streamclip (1.9.2 -- NOT the beta version) and ProRes 
was available.

If you don't have ProRes installed, two other high-quality format options are Apple Animation or Apple 
DVCPRO 50, depending upon how important file size is.

[ Go to Top. ] 

SEARCHING FOR MISSING FILES

Peter Tours writes:

http://www.squared5.com/


Larry, can you tell me what the attached message is asking for and how I can make it 
stop doing that? Or make it happy and find it?

Larry replies: FCP is searching for a missing render file. This can happen when you export a QuickTime 
reference movie, load that reference movie back into FCP for editing, then delete some or all of the 
render files associated with that reference movie.

Reference movies are ONLY designed for files that you don't want to keep -- for example, to export a file 
that will immediately go into Compressor. Since all compressed files are always self-contained, using 
reference movies is both fast and safe.

However, the problem with a reference movie is that if you delete only ONE render file, the entire movie 
will not play. This means that if you want to export a movie, then import it back into Final Cut - or any 
other program - for additional editing, you MUST use a self-contained QuickTime movie.

The only way to fix this error message is to find the original sequence that created this movie and re-
export it as a self-contained QuickTime movie. Then replace the old, broken, reference movie with the 
self-contained version.

Remember - reference movies are fast, but only to be used for files that are temporary.

[ Go to Top. ] 

CONNECTING A SATA HARD DRIVE

Jeffery Templeton asks

I recently attended your seminar here in San Francisco and you talked a bit about 
different connections and their relative speeds. You mentioned that SATA is, of course, 
the fastest. I've always used LaCie drives and most of them have the SATA port, and I 
would like to start utilizing these. My home system is a MacBook Pro Core 2 Duo 17", 
was wondering if you could recommend a SATA PCI express card?

I've gone on-line and looked at several, but the customer reviews of each have scared me 
from taking the plunge with one or the other.

Thanks, for ALL of your help over the years!

Larry replies: Thanks for writing and the kind words!



The safest choice is to go with the SATA card recommended by your hard drive vendor. They will 
always know what works best with their system.

Given that, I tend to be a fan of Sonnet cards. 

Also be SURE your MacBook Pro has an ExpressCard 34 slot (left side of the computer). Without it, you 
can not connect your hard drive via eSATA.
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BOOTING FROM A FLASH DRIVE

Richard Day writes:

That's a great tip in the last issue, booting from a flash drive for repairs and maintenance. 
I did this a couple of months ago, with a new HP 16GB flash drive. But it's VERY slow. I 
think the data transfer rate of your flash drive may be very important when the flash drive 
is used for this purpose. I wonder if a high-speed SD card in a card reader would work 
better? Or do you know of a FAST flash drive?

Larry replies: By design, USB is very slow on a Mac. So, while it works, it will take a while.

[ Go to Top. ] 

A COUPLE OF QUESTIONS

Mark Bradley writes:

After reading your December issues, I have two questions:

1. Someone had a question about the longevity of DVD's. I agree that this is no place to 
skimp on quality. I have been searching for a solution to archive material that is shot 
either to tape or card. Tape won't last forever and P-2 cards are too expensive to keep 
buying. Media drives need to have the data re-recorded/refreshed to keep all of the info 
intact over long periods of time. What is your thought on backing up material? I had this 
crazy notion of backing up materials shot on a P-2 card or ingested tape to a Blu-ray disk. 
The card and disk both hold about the same amount of data. Of course one of the 
problems is Apple and Blu-ray not wanting to play nice. 

Larry replies: At this point, I'm recommending archiving to LTO-4 tape drives. These are the drives 
currently used in IT departments around the world to back up corporate servers. There are lots of 
equipment options from multiple vendors - Tandberg Data, HP, Dell - and the tapes last about 25 years.

I am not a fan of Blu-ray for archiving because I'm not sure how long Sony will be supporting the format. 
However, I do recommend using Blu-ray Discs to distribute HD versions of projects for those that need 
to be on optical disc. 

Mark continues:

2. Another thing I want to get your thoughts on is archiving past/finished projects. Like 
me, I'm sure you have accumulated lots of tapes containing copies of projects you have 
worked on. I am working on a new demo reel and want to convert this material into a 

http://www.tandbergdata.com/us/en/products/drives/lto/


safe, stable and highly usable format. I have stuff on 1 inch, 3/4 inch, beta (SP and 
digital), and about everything else you can think of. Before the oxide turns to dust, I want 
to transfer it. I purchase a small FCP system in November of 2008 to learn FCP because 
more people here are getting rid of their Avids. So, I will be editing on FCP. A local Edit 
Facility will let me use their systems to ingest into an Avid. My plan is to then export the 
materials as an uncompressed quicktime using Animation + Best settings. All of the stuff I 
want to convert is SD. Does this sound like a feasible way of doing things? Any thoughts 
would be appreciated.

Larry replies: A few years ago, I converted all my 2" and 1" materials to both DigiBeta and MiniDV. 
Today, assuming I have Final Cut Pro 7, I'd use ProRes 422 HQ as one of my capture formats.

ProRes provides a high-quality, editable format at a higher quality than any of the tape formats you 
mention in your question.

If I want to archive footage for the indefinite future, I'd use PhotoJPEG at 100% quality. PhotoJPEG, 
while generating files a bit bigger than ProRes, is an open standard that, at 100%, is fully lossless. 
However, it will require rendering in order to edit, unlike ProRes. 

ProRes has higher quality than the Animation codec, while both PhotoJPEG and ProRes create smaller 
files than the Animation codec.
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CAPTURING ANALOG FOOTAGE

Jürgen Toussaint, from Germany, writes:

One thing I am not sure about and that is the system settings for capturing old analog 
footage from Sony ¾ “ NTSC Umatics. So far I am getting always drop [frames] while I 
am trying to transfer the footage on my MAC (10.5). To convert I am using a Pyrow AV 
Link and a Grass Valley “Canopus”. If I use the same tapes and a Dazzle converter with 
the PC and “Pinnacle” from AVID, the transfer works! Same playback machines Sony ¾” 
Umatic. Any idea?

Larry replies: A dropped frame error generally indicates a hard disk that is too slow to support the video 
format you are trying to capture.

Here's an article I wrote that explains this more fully:

www.larryjordan.biz/articles/lj_video_data_rates.html

While I haven't used the specific gear you mention, here are several ideas:

1. Use the PAL DV codec. This is higher quality than U-Matic, but creates relatively small 
file sizes.

2. Be SURE you are capturing to a hard disk that is not your boot disk. In other words, 
use a second drive.

3. Use a hard disk connected via FireWire, not USB. USB runs slower on a Mac than it 
does on a PC. 

This should make for very clean captures.

http://www.larryjordan.biz/articles/lj_video_data_rates.html
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DECIDING WHAT MAC TO BUY

Fredrik, from Sweden, writes:

Thinking about which configuration of a new Mac that best suites either Final Cut or/and 
Premier Pro!? I Will work with both apps including After Effects.

Do you think that the new iMac is fast enough and will transcode and render fast enough. 
I'm working with a Panasonic AG HPX 171 HD camera with 2 32 GB P2 media cards and 
also use a Nexto video "middle" storage disk to transfer full P2 media content while when 
using continuously shooting.

Larry replies: Fredrik, up until I saw the demo of the new Mercury Playback Engine from Adobe, I would 
have said that an iMac would be fine. However, to make the most of the blazing speed of this 
technology requires an NVIDIA graphics card, which can't be added into an iMac.

Still an iMac may be the best choice if you are not creating files that require a lot of rendering. As for 
speculating on the speed of an iMac that Apple hasn't released - well, that's a pretty foolish exercise. I 
long ago decided that all unreleased computers are infinitely fast, as they travel exclusively at the speed 
of thought. 

The big limits to an iMac are that it isn't expandable and can only connect FireWire hard drives and 
RAIDs, which limits file transfer speeds. In some cases, however, newer iMacs are faster than MacPros. 

In general, MacPros will be faster than iMacs - but they cost about twice as much for all that speed and 
expandability. Which means if you need top-of-the-line performance, the MacPro is the better choice.
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ARCHIVING A SEQUENCE

Rick Gennaro asks:

My question is for FCP 6. Is there a way to archive a sequence? If I remember correctly 
from FCP 5, I saved a sequence as an archive, which maintained all the cuts and files so 
that I could 'clean' the rest of the files, etc. from my hard drive, including the source files.

Larry replies: Yes, you can do that using Media Manager. Use the Move option and delete media that is 
not being used.

Be careful! This can be VERY tricky - read the FCP manual first so that you don't delete media you 
actually need.

I created a video tutorial that covers how to do this. You can learn more here.

[ Go to Top. ] 

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=100


VIDEO OUTPUT PROBLEMS WITH SNOW LEOPARD

Adam Connell sent this in:

It turns out that the pro apps late 2009 that updates FCP to 7.0.1 also makes a change to 
QuickTime. 

The file I have selected in shot 1,DesktopVideoOutput.component, (path bar is active so 
you can see where it is) gets updated. It controls Quicktime's output, and is responsible 
for the display of video using desktop cinema preview and to an extent, the preview 
through some realtime cards. It causes playback issues within final cut when you are 
using a second monitor for playback either as digital cinema desktop or a broadcast 
monitor. Incorrect interlacing, bad gamma, and everyones favorite: dropped frames. 

SOLUTION

For affected users I found a fix being discussed on CreativeCow. For those who have an 
install disc for FCP 7 you can find the DesktopVideoOut.componemt file and replace your 
broken one. 

See the file in shot 2. (its on your FCP 7 install disc or in the disc image you made of it) 
Copy this to the desktop. Unzip. It will make a folder called "Library" with folders "Apple" 
and "Quicktime" inside. 



Inside "Quicktime" you will find an original, working, DesktopVideoOut.component file. 
Replace the same one in shot one with this. All will be well again, OSX 10.6.2 with FCP 
7.0.1 (pro apps 2009 installed)

Larry replies: Thanks!

[ Go to Top. ] 

WRAP-UP

Well, that's about it for this newsletter. 

For current news and in-depth interviews on what's happening in our industry, be sure to listen to the 
Digital Production BuZZ every week. In fact, email me on how you can put the free BuZZ player on your 
website! 

�●     Visit our store and buy some of our latest tutorials. 
�●     Check out our current seminar series, I'd love to meet you there! 

Also, please continue sending me your comments and questions. I love hearing from you and enjoy the 
conversations that develop around your comments.

Until next month, take care, and edit well.

Larry

Subscribe to Larry's FREE

Monthly Newsletter! 

Email:    

 

[ Click here for a printer-friendly PDF version of this issue. 1.9 MB ]
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Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends to sign 
up at www.larryjordan.biz/newsletter.

To unsubscribe, simply send me an email and I'll remove you from the list. This list is not 
sold, rented, or bartered. The only person who knows you are on this list is me.

The information in this newsletter is believed to be accurate at the time of publication. 
However, due to the variety of possible system and software configurations, the author 
assumes no liability in case things go wrong. Please use your best judgment in applying 
these ideas.

The opinions expressed in this newsletter are solely those of the author. This newsletter 
has not been reviewed or sanctioned by Apple or any other third party. All trademarks are 
the property of their respective owners and are mentioned here for editorial purposes only.

Text copyright 2009 by Larry Jordan & Associates, Inc. All rights reserved. This newsletter 
may not be reproduced or published in any way, in whole or in part, without specific 
written permission from the author. 

Links to my home page, blog, or website articles are welcome and don't require prior 
permission. 
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